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Warranty 
The material contained in this document 
is provided “as is,” and is subject to 
being changed, without notice, in future 
editions. Further, to the maximum 
extent permitted by applicable law, 
Agilent disclaims all warranties, either 
express or implied, with regard to this 
manual and any information contained 
herein, including but not limited to the 
implied warranties of merchantability 
and fitness for a particular purpose. 
Agilent shall not be liable for errors or 
for incidental or consequential damages 
in connection with the furnishing, use, or 
performance of this document or of any 
information contained herein. Should 
Agilent and the user have a separate 
written agreement with warranty terms 
covering the material in this document 
that conflict with these terms, the 
warranty terms in the separate 
agreement shall control. 

Technology Licenses 
The hardware and/or software 
described in this document are 
furnished under a license and may be 
used or copied only in accordance with 
the terms of such license. 

Restricted Rights Legend 
U.S. Government Restricted Rights. 
Software and technical data rights 
granted to the federal government 
include only those rights customarily 
provided to end user customers. 
Agilent provides this customary 
commercial license in Software and 
technical data pursuant to FAR 12.211 
(Technical Data) and 12.212 
(Computer Software) and, for the 
Department of Defense, DFARS 
252.227-7015 (Technical Data - 
Commercial Items) and DFARS 
227.7202-3 (Rights in Commercial 
Computer Software or Computer 
Software Documentation). 

Safety Notices 

A CAUTION notice denotes a hazard. It 
calls attention to an operating 
procedure, practice, or the like that, if 
not correctly performed or adhered to, 
could result in damage to the product 
or loss of important data. Do not 
proceed beyond a CAUTION notice 
until the indicated conditions are fully 
understood and met. 

A WARNING notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, if 
not correctly performed or adhered to, 
could result in personal injury or death. 
Do not proceed beyond a WARNING 
notice until the indicated conditions 
are fully understood and met. 
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General 

Unless otherwise specified, statements in this manual apply to both the Agilent 
5800 and 5900 ICP-OES instruments. 

Operation of an Agilent ICP-OES involves the use of compressed gases, high 
voltage radio frequency energy and hazardous materials including corrosive fluids 
and flammable liquids. Careless, improper or unskilled use of this spectrometer or 
chemicals used with it can cause death or serious injury to personnel, and/or 
severe damage to equipment and property. Only trained personnel should use this 
instrument. 

The spectrometer incorporates interlocks and covers that are designed to prevent 
inadvertent contact with any potential hazards. If the instrument is used in any 
manner not specified by Agilent, this protection provided by the equipment may be 
impaired. It is good practice to develop safe working habits that do not depend 
upon the correct operation of the interlocks for safe operation. It is essential that 
no interlock or cover is bypassed, damaged or removed. 

The safety practices described below are provided to help the user operate the 
instrument safely. Read each safety topic thoroughly before attempting to operate 
the instrument and always operate the spectrometer in accordance with these 
safety practices. 
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Verifying Safe State 

The following general safety precautions must be observed during all phases of 
operation, maintenance and service of this instrument.  

To ensure continued safety of the instrument after maintenance or service 
procedures verify the instrument is returned to a safe state for the user. This 
includes running performance checks to verify the instruments safety systems are 
functioning correctly. Check the general condition of the instrument during 
operation for wear or signs of corrosion that are likely to inhibit function or safety. 

Failure to comply with these precautions or with specific warnings elsewhere in 
this manual violates safety standards of design, manufacture, and intended use of 
the instrument. Agilent Technologies assumes no liability for the customer’s 
failure to comply with these requirements. 

Plasma 

The plasma is extremely hot (about 10,000 °C) and radiates dangerous levels of 
radio frequency (RF) and ultraviolet (UV) energy. The work coil operates at 1,500 V 
RMS and about 27 MHz. Exposure to the RF and UV energy can cause severe skin 
damage and cataracts of the eyes, while close contact with the operating plasma 
can result in severe heat burns to the skin, and an electrical discharge that can 
jump a considerable distance and may cause death, severe electric shock or sub-
surface skin burns. 

The plasma must never be operated unless:  
 the plasma compartment door is closed, with the door handle fully closed; and 
 the space above the chimney and air intake is clear of objects. 

The shielding around the torch compartment is designed to reduce UV, visible and 
RF radiation to safe levels while still permitting easy access to, as well as 
installation and viewing of, the torch. The spectrometer has an interlock system 
that is designed to extinguish the plasma if the mains supply fails, the handle on 
the torch compartment door is opened, or the torch loading handle is open. Do not 
attempt to bypass the interlock system. 
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Before opening the torch compartment door, always extinguish the plasma by 
pressing SHIFT + F5 on the keyboard or by clicking the ‘Plasma Off’ icon on the 
ICP Expert software toolbar. 

The torch and its surroundings remain hot for up to five minutes after the plasma 
is extinguished. Touching this area before it has cooled sufficiently may result in 
burns. Allow the torch and torch compartment to cool before carrying out any 
work in this area, or wear heat-resistant gloves. 

The plasma system has been carefully designed to operate safely and effectively 
when using torches and related components that conform to Agilent’s design 
criteria. Use of non-approved components in the plasma compartment may render 
the system inoperative and/or hazardous. It may also invalidate the warranty on 
the instrument. Use only torches and related components supplied or authorized 
by Agilent. 

Heat, Vapors and Fumes 

Heat, ozone, vapors and fumes generated by the plasma can be hazardous and 
must be extracted from the instrument by means of an exhaust system. Ensure 
that an exhaust system of the appropriate type is fitted (as specified in the Site 
Preparation Guide). The system must be vented to the outside air in accordance 
with local regulations and never within the building. Regularly check the exhaust 
system by smoke test to ensure that the exhaust system is functioning correctly. 
The exhaust system must always be switched on before igniting the plasma. 

Compressed Gas Hazards 

All compressed gases (other than air) can create a hazard if they leak into the 
atmosphere. Even small leaks in gas supply systems can be dangerous. Any leak 
(except that of air or oxygen) can result in an oxygen-deficient atmosphere, which 
can cause asphyxiation. The area in which cylinders are stored and the area 
surrounding the instrument must be adequately ventilated to prevent such gas 
accumulations. 
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Gas cylinders must be stored and handled strictly in accordance with local safety 
codes and regulations. Cylinders must be used and stored only in a vertical 
position and secured to an immovable structure or a properly constructed cylinder 
stand. Move cylinders only by securing them to a properly constructed trolley. 

Use only approved regulator and hose connectors (refer to the gas supplier’s 
instructions). Keep gas cylinders cool and properly labeled. (All cylinders are fitted 
with a pressure relief device that will rupture and empty the cylinder if the internal 
pressure is raised above the safe limit by excessive temperatures.) Ensure that 
you have the correct gas before connecting it to the instrument. 

The primary gas used with the spectrometer is argon, which is the conductive gas 
for the plasma. Argon or nitrogen can be used as the polychromator purge gas. 
Other gases may be required for future options and accessories. Use only 
‘instrument grade’ gases with your spectrometer. 

If using cryogenic gases (for example, liquid argon), prevent severe burns by 
wearing suitable protective clothing and gloves. 

Electrical Hazards 

The spectrometer system and some accessories contain electrical circuits, 
devices and components operating at dangerous voltages. Contact with these 
circuits, devices and components can cause death, serious injury or painful 
electric shock. Panels or covers which are retained by screws on the spectrometer 
and accessories may be opened only by Agilent­trained, Agilent-qualified or 
Agilent­approved field service engineers (unless specified otherwise). Consult the 
manuals or product labels supplied with your personal computer (PC), monitor, 
printer and water-cooling system to determine which parts of those systems are 
operator-accessible.  

Connecting the Agilent ICP-OES to a power source that is not equipped with a 
protective earth contact creates a shock hazard for the operator and can damage 
the instrument. Likewise, interrupting the protective conductor inside or outside 
the Agilent ICP-OES or defeating the power cord ground creates a shock hazard 
for the operator and can damage the instrument. 
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Other Precautions 

Use of the spectrometer system and accessories may involve materials, solvents 
and solutions which are flammable, corrosive, toxic or otherwise hazardous. 
Careless, improper or unskilled use of such materials, solvents and solutions can 
create explosion hazards, chemical burn hazards, fire hazards, toxicity and other 
hazards that can result in death, serious personal injury or damage to equipment. 
Apply all necessary precautions including use of lab coats, safety goggles and 
other appropriate forms of personal protection. All wastes should be disposed of 
in accordance with local regulatory requirements. 

Operation of an ICP-OES involves analysis of solutions that have been prepared in 
or digested with acids, or in some cases, samples that have been prepared in 
organic solvents.  

In case of uncertainty about a specific fluid, that fluid should not be used until 
confirmation by the manufacturer that it will not present a hazard. 

The acid concentration in the sample that is measured varies, depending upon the 
digestion steps and acid types used. Instrument users should be aware of the 
hazards associated with use of the acids used for sample preparation and apply 
all necessary precautions including use of lab coats, safety goggles and other 
appropriate forms of personal protection. The acid wastes should be disposed of 
in accordance with local regulatory requirements. 

The type, volatility and concentration of the organic solvents used in the sample 
that is measured varies, depending upon the selected solvent and the sample 
preparation involved. Instrument users should be aware of the hazards associated 
with use of the organic solvents for sample preparation, and apply all necessary 
precautions including ensuring adequate ventilation during use, and use of lab 
coats, safety goggles, gloves and other appropriate forms of personal protection. 
The organic wastes should be disposed of in accordance with local regulatory 
requirements. 

Air flow to the air intake port of the spectrometer and accessories must be 
unobstructed. Do not block the ventilation grills on the spectrometer and 
accessories. Consult the manuals supplied with your PC, monitor, printer and 
water-cooling system for their specific ventilation requirements. 

Great care should be taken when working with glass or quartz parts to prevent 
breakage and cuts. This is especially important when inserting the nebulizer into 
the spray chamber or removing and replacing pieces of broken torch. 
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The spectrometer weighs approximately 90 kg (200 lb). To avoid injury to 
personnel or damage to the instrument or property, always use suitable 
mechanical lifting device to move the instrument. 

Use only Agilent-supplied or approved spares with your instrument Only trained 
operators should use the instrument. 

Warning Symbols 

The following is a list of symbols that may appear in conjunction with warnings in 
this manual or on the spectrometer. The hazard they describe is also shown. The 
beginning of the warning text is noted by a warning icon: 

WARNING 

A triangular symbol indicates a warning. The meanings of the symbols that may 
appear alongside warnings in the documentation or on the instrument itself are as 
follows: 

 
Broken glass 

 
Chemical hazard 

 
Disconnect power 

 
Electrical shock 

 
Extreme cold hazard 

 
Eye hazard 

 
Fire hazard 

 
Heavy weight 

(danger to feet) 

 
Heavy weight 

(danger to hands) 

 
Hot surface 

 
Noxious gases 

 

RF radiation 
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The following symbol may be used on warning labels attached to the instrument. 
When you see this symbol, refer to the relevant operation or service manual for the 
correct procedure referred to by that warning label. 

 
The following symbols appear on the instrument for your information. 

I Mains power on 

0 Mains power off 

 
Single phase alternating current 

 

Protective ground terminal. 

 
Socket for Agilent accessory serial cable  

 
Socket for Ethernet LAN cable 

 
Socket for Agilent accessory USB cable 

 

Indication of correct orientation of gas filter flow direction 

  

Caution, disconnect all supplies, risk of electric shock 

 

 
  



Safety Practices and Hazards 

14 Agilent 5800 and 5900 ICP-OES User's Guide 

 

This page is intentionally left blank. 



Introduction 

Agilent 5800 and 5900 ICP-OES User's Guide 15 

2 Introduction 
Site Preparation Requirements 15 
User Documentation 15 
ICP-OES Argon Gas Supply 16 
Exhaust System 17 
ICP-OES Instrument Cooling Air Supply 17 
Water Chiller System 18 
Drain Vessel 18 

Site Preparation Requirements 

Prior to receiving your instrument, you will have been provided with an Agilent 
5800 and 5900 ICP-OES Site Preparation Guide, which describes the 
environmental and operating requirements of the ICP-OES system. You must 
prepare your laboratory according to these instructions before the ICP-OES can be 
installed. You should keep the Site Preparation Guide for future reference for 
example, if you plan to move your instrument. If you have misplaced your copy, 
you can obtain a free replacement from your local Agilent office.  

Position the equipment for easy access to the disconnecting switch on the left 
side of the instrument. 

User Documentation 

You have been provided with the following documentation to help you set up and 
operate your Agilent ICP-OES system: 

 This User’s Guide, with safety practices and hazards information, instructions 
for finding information about installing and maintaining the components of the 
ICP-OES and a brief operation overview. 
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 An extensive Help and Learning Center containing context-sensitive Help with 
information on how to set up methods and run instrument tests, hardware 
basics and maintenance videos, step-by-step instructions for frequently 
performed operations and instructions for using any accessories you ordered. 

Conventions 

The following conventions have been used throughout the documentation: 

 Menu items, menu options and field names (for example, click Copy from the 
Edit menu) have been typed in bold. Bold is also used to signify the buttons 
appearing throughout the software (e.g., click OK). 

 ALL CAPITALS indicate keyboard commands (e.g., press the F2 key) and text 
you must type in from the keyboard (e.g., type SETUP at the prompt). 

Notes and tips 

A Note is used to give advice or information. 

A Tip is used to give practical hints to help you achieve the best possible 
performance from your ICP-OES. 

ICP-OES Argon Gas Supply 

Table 1. Typical flow rates for the Agilent ICP-OES instruments 

Typical Flows Argon (with nitrogen purge gas) 

Measuring wavelengths  
> 189 nm (poly boost off) 

Argon flow 16.7 L/min 
Nitrogen flow 0.8 L/min 

Measuring wavelengths  
< 189 nm (poly boost on) 

Argon flow 16.7 L/min 
Nitrogen flow 4.4 L/min 

Argon can be used as a plasma gas and purge gas which results in a higher total 
argon flow rate. 

The user (or other authorized personnel) must carry out appropriate leak tests 
necessary to ensure safety on the gas and liquid connections that the operator is 
directed to assemble during installation, normal use or maintenance. 
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Exhaust System 

The plasma operates at extremely high temperatures. The ICP-OES instrument 
exhaust fumes can be noxious or corrosive. 

The exhaust system should be checked regularly to ensure adequate flow. Consult 
the ICP-OES Site Prep Guide for the appropriate flow rates. 

 

WARNING 

 
 

Hot Surface 
The external vent may become hot during ICP-OES instrument operation 
and remain hot for some time after the instrument has been switched off. 
Allow the external vent to cool for at least five minutes before attempting 
to remove the exhaust hose. Use heat-resistant gloves. 

 

ICP-OES Instrument Cooling Air Supply 

The ICP-OES instrument requires clean, dry, non-corrosive air for cooling purposes. 
This is supplied to the instrument through an air supply vent located at the top, left 
of the instrument. The vent has a dust filter, to filter out particulate matter. 

The air supply is used to cool the internal mechanical and electronic components 
of the instrument. Several of these assemblies contain parts prone to corrosion. 
The introduction of cooling air contaminated with high levels of acid vapors or 
other corrosive substances may cause damage to the instrument. 

Due to the corrosive nature of some analytical work, it is recommended that in 
applications demanding high usage of corrosive materials, an external cooling air 
supply system is provided. It is required that the cooling air be supplied from an 
environmentally-controlled area that is away from the instrument exhaust and any 
other area where corrosive materials are stored or used. Do not duct humid, warm 
air into an instrument in a cooled laboratory environment. 

The cooling air system with flue, fan, ducting and supply cowl, must provide 
positive air pressure at the instrument inlet of 4 m3/min (141 ft3/min) when using 
the External Inlet Duct Adaptor Kit. The ducting should be corrosion-resistant and 
fire-proof. 
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Water Chiller System 

Agilent ICP-OES instruments require a source of cooling water. Refer to the Site 
Preparation Guide for compatible water chilling systems and to the documentation 
provided with the water chilling system for installation and use instructions. 

NOTE Pressure regulation is recommended for supplies where the cooling water 
pressure may be subject to fluctuations. Pressure regulation is necessary for 
supplies that may exceed the maximum permissible pressure of 400 kPa (58 psi). 

 

The instrument is equipped with a water flow sensor, which will stop operation of the 
plasma if the cooling water flow through the instrument drops below 1.7 L/min (0.45 
gpm). A second water flow sensor will stop the camera Peltier cooling assembly if the 
water flow through the instrument drops below 0.2 L/min (0.05 gpm). 

 

CAUTION Always ensure the water chiller system is on before igniting the plasma. 

Drain Vessel 

The Agilent ICP-OES system needs a drain vessel for disposal of excess fluids 
from the spray chamber or autosampler. Suitable tubing is supplied with the 
spectrometer for use with inorganic solvents. When using organic solvents, 
different drain tubing that is suitable for the solvent in use will be required. 

A chemically inert container, not glass or of a narrow-necked style, to hold a 
minimum of 2 liters (4 pints) of waste must be provided by the user. It should be 
located underneath the sample compartment (or on the right side of the 
instrument), where it is protected by the bench and in full view of the operator. 
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The Agilent ICP-OES must be installed by an Agilent-trained, Agilent-qualified or 
Agilent-authorized field service engineer. 

You should have completed and returned the form in the Site Preparation Guide 
stating that you have prepared the laboratory in accordance with the requirements 
detailed in that manual. An Agilent representative will then arrange a suitable 
installation date with you. 

Details for unpacking the instrument and what to do in case it has been damaged 
in transit are also outlined in the Site Preparation Guide. 
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Agilent ICP-OES Instrument Overview 

 
Figure 1. Front and side of the ICP-OES instrument 

1. Exhaust 8. Torch loader handle 15. Torch compartment handle 

2. Air inlet filter 9. Spray chamber 16. Water inlet assembly 

3. Pre-optics cone and axial 
viewing window (not shown) 

10. Nebulizer 17. Optics purge filter for argon or 
nitrogen 

4. Snout and radial viewing 
window (not shown) 

11. Peristaltic pump 18. Gas supply assembly 

5. Work coil 12. Mains power switch and 
cable connection  

19. Optional AVS 4, AVS 6 or AVS 7 
Switching Valve accessory location 

6. Torch 13. Front panel power button 20. Drain for liquid overflow 

7. Nebulizer and make up gas 
connections 

14. LED instrument status 
indicator 
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All connections of services to the ICP-OES instrument are made on the right side 
of the instrument, except for the mains power which is on the left side of the 
instrument. Remove the cover on the right side by hand to gain access to the 
Ethernet, accessory, water and gas connections. The Power on/off button is 
located on the front lower left side of the instrument and the mains power switch 
is located on the left back side of the instrument. 

 
Figure 2. Input and output connections on the side of the ICP-OES instrument 

 Item Description 
1 Accessory and LAN 

cable connections 
Agilent accessory connections and shielded Ethernet cable 
for PC to instrument communication 

2 Argon gas inlet Argon gas inlet, standard 
3 Option gas inlet  Option gas inlet: only supports 80% Ar/20% O2  
  Optional nitrogen gas inlet (not shown) 
4 Optics purge filter Argon or nitrogen gas filter 
5 Water outlet Connect to return from the water chiller 
6 Water filter Coarse particulate water filter 
7 Water inlet Connect to supply from the water chiller 

3 

5 

2 

7 

1 

6 

4 
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Instrument Status LED Color Coding 

The instrument status indicator light on the front top right of the Agilent ICP-OES 
displays different colors to represent the status of the instrument:  
 A green light indicates the following: 

 The instrument and software are connected and are ready to attempt a 
plasma ignition sequence, or 

 The instrument and software are connected and the plasma ignition 
sequence is underway, or 

 The instrument and software are connected, the plasma is lit and running 
and it is possible to run analysis of samples. 

 A yellow blinking light indicates the instrument and software are not 
connected (instrument is off-line). 

 A yellow light indicates that the instrument and software are connected, but 
the instrument is not ready to begin a plasma ignition sequence due to a 
tripped door or torch handle interlock, low gas pressure, low water flow or low 
cooling air flow. User intervention is required to resolve the problem. 

 An orange pulsing (intensifying/fading) light indicates the instrument is 
booting up or performing a firmware update.  

 A red light indicates an instrument firmware error causing a halt to analysis or 
restricting normal instrument operation. User intervention is required to 
resolve the problem. 

Front Power On/Off Button 

The LED in the front on/off button indicates the basic instrument on/off state. 
 Off indicates that the instrument is completely unpowered when the mains 

power switch on the left side of the instrument is also off. 
 Green flash once every 10 seconds indicates most of the instrument is 

unpowered, with the exception of the front panel Power on/off button switch 
sensing circuit inside the mains power module. Press the front panel Power 
on/off button at the front to fully power up the instrument. 

 Green blinking slow (1 Hz). The mains power module is initializing and running 
through power up self-check, or is shutting off the instrument. 
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 Green blinking fast (2 Hz). Mains power module failed its initialization power-
up self-check, instrument is unusable. The mains power supply is not 
adequate or the internal mains module needs to be replaced.  

 Green constantly on indicates the instrument is switched on. 

ICP Expert Software 

The Agilent-trained, Agilent-qualified or Agilent-authorized field service engineer 
will install the ICP Expert software for you during the installation process. 
However, you may need to install the software yourself at some later stage, for 
example if you change the PC. Instructions are provided. 

There are several installation scenarios: 
 Standalone  
 Standalone or Network Database for 21 CFR Part 11 installations 
 Upgrading Standalone or Network Database ICP Expert installations 

 

Installation includes: 
 Installing the ICP Expert software 
 Installing the ICP Expert Help 
 Installing the LAN cable  
 Setting the instrument IP address 
 Installing and configuring SDA for 21 CFR Part 11 compliance 
 Installing and configuring SCM for 21 CFR Part 11 compliance 
 Completing a dark current scan and wavelength calibration 

For instructions on how to install your ICP Expert software, refer to the 
documentation provided with your software: 
 ICP Expert Software Installation Instructions 
 ICP Expert Software Installation Instructions for 21 CFR Part 11 Environments  

Once you have installed the appropriate software, connect the Ethernet cable, set 
the instrument IP address if necessary, and then perform the Detector Calibration 
and Wavelength Calibration.  
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Connecting ICP Expert software to the ICP-OES 

To connect the software and instrument: 
1 Start the ICP Expert software by double-clicking on the desktop icon. 
2 Click Instrument. 
3 Click Connect. 
4 Enter the IP address of the instrument or select an existing instrument. 
5 Click Connect. 
6 Click Close. 

Performing a Detector and Wavelength Calibration  

To perform a detector and wavelength calibration: 
1 Turn on the external exhaust.  
2 Start the ICP Expert software and open the Instrument Window. 
3 Connect the software to the instrument, if needed. 

a Click Instrument in the ICP Expert toolbar.  
b Click Connect. 
c Select the instrument from the list and the click Connect. 

4 Click Calibrate in the ‘Detector’ section. 

NOTE Once the detector calibration is completed, the date and time of the last successful 
calibration will be displayed, confirming the detector measurement has been 
completed. 

 

5 Ensure a standard glass concentric nebulizer, a double pass spray chamber 
and the appropriate plasma torch (for radial or dual view) are installed. Use 
manual sampling. The recommended peristaltic pump tubing is White/White 
for the pump and Blue/Blue for the drain. 

6 Ignite the plasma.  
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7 Check that the Polychromator Boost purge is on. 
a On the ‘Instrument’ window of the ICP Expert software, click the Status tab 

and check that under the Polychromator section Boost is selected. 
b If the instrument was turned on from an idle state, the wavelength 

calibration in Steps 8-9 can be performed immediately. If the instrument 
was turned on after more than a few hours of being unpowered, the 
polychromator can take several hours to stabilize the temperature and to 
purge. 

8 Aspirate the wavelength calibration solution and then select the Calibration 
tab.  

9 Click Calibrate in the ‘Instrument’ section to perform a wavelength calibration. 

NOTE Once completed, the date and time of the last successful calibration will be 
displayed, a pass or fail mark will appear along with the wavelength error indicating 
whether the instrument calibration is complete. 

Saving and viewing the calibration data 

The calibration data is stored in the Logs. To view the data, export the Logs. 
1 From the main ICP Expert window, click File > Logs > Export Logs.  
2 Save the zipped Log file.  
3 Open the .zip file to view the Log files. 

NOTE The default save location is \Users\’Username’\Documents\Agilent\ICP Expert 
\Exported Results\ on the drive on which the ICP Expert software is installed. 

 

Hardware Components Replacement 

Your ICP-OES should be ready to operate after the Agilent field service engineer 
has installed it. However, you may need to set up items such as the peristaltic 
pump, nebulizer, torch or spray chamber. For instructions on how to do this, please 
refer to the ‘How to’ section in the ICP Expert Help and Learning Center.  

  



Installation 

26 Agilent 5800 and 5900 ICP-OES User's Guide 

ICP-OES torches 
The range of ICP-OES torches are listed below, each with unique properties to suit 
a wide range of applications. Additional torches may be available. See the Agilent 
website for more information. 

 

Parameter 
Dual View Torches  

Standard torch Semi-demountable 
torch 

Inert semi-
demountable torch 

High solids semi-
demountable torch 

Construction One piece 
Two piece 
demountable 

Two piece 
demountable 

Two piece 
demountable 

Injector inner diameter 
(mm) 1.8 1.8 1.8 2.4 

Injector material Quartz Quartz Ceramic Quartz 

Outer tube length Medium with slot Medium with slot Medium with slot Medium with slot 

Outer tube material Quartz Quartz Quartz Quartz 

Intermediate tube Quartz tulip Quartz tulip Quartz tulip Quartz tulip 
Recommended 
application 

Most sample types Most sample types Hydrofluoric (HF) 
acid digests 

Samples with high 
total dissolved solids 

 
 

Parameter 
Radial View Torches  

Standard torch Semi-demountable torch Inert semi-demountable torch 

Construction One piece Two piece demountable Two piece demountable 
Injector inner 
diameter (mm) 1.4 1.4 1.8 

Injector material Quartz Quartz Ceramic 

Outer tube length Short (no slot) Short (no slot) Short (no slot) 

Outer tube material Quartz Quartz Quartz 

Intermediate tube Quartz tulip Quartz tulip Quartz tulip 
Recommended 
application 

Most sample types Most sample types Hydrofluoric (HF) acid digests 
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Parameter 
Fully Demountable Torches  

Standard Inert High solids Semi-volatile organics Volatile organics 

Construction Fully 
demountable 

Fully 
demountable 

Fully 
demountable Fully demountable Fully demountable 

Injector inner 
diameter (mm) 1.8 1.8 2.4 1.4 0.8 

Injector material Quartz Ceramic Quartz Quartz Quartz 

Outer tube length Medium with 
slot 

Medium with 
slot 

Medium with 
slot Medium with slot Short (no slot) 

Outer tube 
material Quartz Quartz Quartz High purity quartz (for 

organic solvents) 
High purity quartz (for 
organic solvents) 

Intermediate tube Quartz tulip Quartz tulip Quartz tulip Quartz tulip Quartz tulip 

Recommended 
application 

Most sample 
types 

Hydrofluoric 
(HF) acid 
digests 

Samples with 
high total 
dissolved solids 

Semi-volatile organic 
solvents e.g. ketones, 
kerosene, Jet-A1 

Volatile organic 
solvents e.g., gasoline 

 

A fully demountable torch can be adapted for another application by replacing the 
injector and/or the outer tube with the configuration recommended for that 
sample type. Refer to the Agilent Technologies website for ordering information. 

Torch Assembly and Disassembly 

Both the semi- and fully demountable torch models allow the outer/intermediate 
tube-set to be separated from the base/injector for easier cleaning or replacement. 
In addition, the fully demountable torch models allow the injector to be removed 
from the base for easier cleaning or replacement.  

 

WARNING 

  

Hot Surface  
The torch and torch compartment may become extremely hot during 
instrument operation and remain hot so for some time after the plasma has 
been switched off. Allow the plasma compartment to cool for at least five 
minutes before accessing the plasma compartment. Allow the torch to cool 
for two minutes before touching the outer tube or attempting to dismantle 
the torch. 
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WARNING 

  

Chemical Hazard 
Nitric acid, hydrochloric acid and strong alkali solutions are very corrosive 
and can cause severe burns when they come into contact with the skin. It is 
essential that appropriate protective clothing be worn at all times when 
handling these acids. If acid contacts the skin, wash off with copious 
amounts of water and seek medical attention immediately. 

 

CAUTION To prevent damage to the torch, always take care when handling or storing it.  
To prevent damage to the instrument, do not use the torch if it is damaged or 
wet. 

 

 
Figure 3. Demountable torch where: 1. Torch, 2. Top seal and 3. Torch body 

Assembly of the semi-demountable torch 

To assemble the torch: 
1 Place the top seal back on the quartz tube-set, slide the clean seal back onto 

the tube-set from the bottom end, making sure the top flat face of the seal is 
positioned facing the top of the tube-set. See Figure 4. 

3 

2 

1 
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Figure 4. The top seal being refitted to the quartz outer tube-set 

2 Slide the top seal approximately 1/3 the way up the quartz tube-set and 
position it so the top face of the seal is aligned with the bottom of the “T” 
alignment mark as shown in Figure 5. 

 
Figure 5. The top seal aligned with the alignment mark on the quartz outer tube 
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3 Gently slide the quartz tube-set into the torch body, avoiding contact with the 
injector. 

 
Figure 6. Torch inserted into torch body 

4 Position the quartz tube-set so that the groove on the torch body aligns with 
the “T” alignment mark on the quartz tube-set as shown in Figure 7. 

 
Figure 7. The alignment mark on the quartz outer tube-set should be aligned with the groove on 
the torch body 

5 Press the quartz outer tube-set fully into the torch body and then press down 
on the top seal to secure the tube-set in place. See Figure 8. 
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Figure 8. Ensure the seal is properly seated by pressing firmly on the top edges 

Assembly of the fully demountable torch 

To assemble the torch: 
1 Unscrew the locking nut on the torch base. 
2 Place the top seal back on the top of the torch base and ensure this is properly 

seated by pressing firmly on the top edges. 
3 Insert the tube-set into the torch body and position it so that the groove on the 

torch body aligns with the “T” alignment mark on the tube-set. Press the outer 
tube-set fully into the torch body. See Figure 7 and Figure 8. 

4 Fully insert the injector through the base of the torch body until the bulge 
contacts the retaining arm and “clicks” into position. 

 
5 Replace the locking nut and tighten to secure the injector.  

CAUTION Hand tighten only. Do not overtighten or use a wrench for leverage. 

 

1 

2 
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Torch disassembly 

To disassemble a semi-demountable torch: 

You may need a flat head screwdriver to loosen the securing ring if you cannot 
gently slide the torch out of the torch body by hand. 

CAUTION Only use the screw driver to loosen the torch securing ring from the torch body if 
you are unable to do so by hand. 

1 Gently loosen the top seal, either by prodding it using thumb nail (see Figure 9) 
or use a wide blade flat screwdriver to lever it up. When using a screwdriver, 
insert the screwdriver into the slot as shown in Figure 10, maintaining an up-
down action to lever the seal loose. Repeat the action on the opposite slot. 
The seal should be dislodged from the torch body. 

 
Figure 9. Removing the top seal on a semi-demountable torch by prodding it using a thumb nail 
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Figure 10. Removing the top seal with an aid of a wide blade flat screwdriver 

2 Maintaining a straight parallel movement, carefully slide the quartz outer tube-
set off the torch body. See Figure 11. 

 

 
Figure 11. Removing the quartz tube-set from the torch body 

Avoid contact between the 
quartz tube-set and injector 
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3 To remove the top seal off the quartz tube-set, slide the seal towards the top 
end of the tube-set. See Figure 12. 

 
 

Figure 12. Removing the top seal off the quartz tube-set 

To disassemble the fully demountable torch: 
1 Unscrew the locking nut on the base of the torch and remove the injector by 

gently pulling on the ball joint. 

 

2 Remove the quartz tube-set from the top of the torch base. If the top seal is 
removed with the quartz outer tube-set, slide the top seal off the tube-set 
towards the top end. 
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See Page 54 for the torch cleaning procedure. 

Accessories 

The following accessories may be available for use with your ICP-OES instrument: 
 SPS 4/6 Autosampler 
 Advanced Valve System (AVS) — AVS 4, AVS 6 and AVS 7 switching valves 
 Advanced Dilution System 2 (ADS 2) 
 External inlet duct adapter 
 Vapor generation accessory (VGA) 
 Multimode sample introduction system (MSIS) 
 Argon humidifier 
 IsoMist Programmable Temperature Spray Chamber 

For safety and installation information, please see the accessory documentation 
or the ICP Expert Help and Learning Center. 

SPS 4/6 

See the instructions that came with the accessory for safety information and to 
prepare the SPS 4/6 for installation.  

The SPS 4/6 is compatible with a wide range of commercially available low-cost 
autoclavable sample racks.  

Sample contamination from airborne particles is eliminated and corrosive or toxic 
fumes are removed during sampling with the optional environmental enclosure. 
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Advanced Valve System (AVS) — AVS 4, AVS 6 and AVS 7  

For safety information and to prepare the accessory for installation, please see the 
instructions that came with the accessory. 

The integrated AVS 4 (4 port switching valve) rinses the sample introduction 
system while the next sample is being presented to the instrument prior to 
measurement. Excess sample is diverted away from the spray chamber and rinse 
is introduced immediately after measurement. This will reduce sample carry-over 
and required cleaning frequency of sample introduction components. 

The integrated AVS 6 (6 port switching valve) and AVS 7 (7 port switching valve) 
increase sample throughput and decrease turnaround time and operating costs. 
The switching valve is positioned between the nebulizer and the peristaltic pump 
of the spectrometer. Samples are quickly loaded into the sample loop, ready for 
immediate analysis by the ICP-OES, greatly reducing sample uptake delays. Pre-
emptive rinsing of the sample line means sample to sample analysis times are 
reduced. 

The AVS 6 and AVS 7 include a bubble injector that automatically injects bubbles 
after the sample is loaded into the loop, isolating the sample from the rinse/carrier 
solution. This reduces the volume of sample required for measurement (therefore 
reducing analysis time) as tailing (or dilution) effects are minimized. 

Advanced Dilution System 2 (ADS 2)  

The ADS 2 provides users three dilution functions automating analysis capability:  
 Autocalibration – automatic preparation of calibration standards. 
 Prescriptive dilution – automatic dilution of samples by a prescribed factor.  
 Reactive dilution – automatic dilution of a sample based upon its analysis 

result to bring the analytes into the calibration range of the analysis. 

The ADS 2 is controlled through software via a serial communications link from 
the spectrometer to the ADS 2. 

External Inlet Duct Adapter  

The External Inlet Duct Adapter provides an attachment for ducting air into the air 
intake port, for use in labs with harsher environments. 
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Vapor Generation Accessory (VGA) 

The VGA 77P is a continuous flow vapor generation accessory for Inductively 
Coupled Plasma-Optical Emission Spectroscopy (ICP-OES) instruments that 
determines Hg and the hydride-forming elements at parts per billion (ppb) levels. 
The entire plumbing assembly is integrated into a separate module and can be 
simply exchanged when switching elements. 

Multimode Sample Introduction System (MSIS) 

For safety information and to prepare the MSIS for installation, please see the 
instructions that came with this accessory and the ICP Expert Help. 

The MSIS is used with the ICP-OES instrument to provide simultaneous vapor 
generation of several hydride forming elements, enabling determination with low 
ppb detection limits. 

The MSIS consists of a nebulizer and modified glass cyclonic spray chamber that 
has two vertical conical tubes in the center of the chamber. This allows for 
reductant and sample to mix quickly and thoroughly in the chamber using thin film 
hydride technology to form the hydrides. 

The MSIS can be operated in three modes: hydride only, simultaneous hydride and 
conventional nebulization or conventional nebulization only. 

Argon Humidifier 

The Argon Humidifier is commonly used when running aqueous samples with high 
dissolved solids or high dissolved salt content. When using the accessory, the 
nebulizer gas flow is passed through the humidifier to increase the water vapor in 
the gas. This has been found to be beneficial by reducing the build-up of salt and 
other dissolved solids in the nebulizer tip in the sample introduction system. By 
reducing blockages, the Argon Humidifier helps to ensure uninterrupted, 
maintenance-free operation. 

IsoMist Programmable Temperature Spray Chamber 

IsoMist utilizes the Peltier effect to provide electrical cooling or heating to the 
spray chamber.  

The ‘Set Temperature’ is monitored and controlled via the ICP Expert software. The 
IsoMist performance can be monitored and controlled from a lab PC via USB or 
Bluetooth wireless technology. 
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This chapter provides a quick guide to getting the instrument set up and running 
samples. 

You will find step-by-step instructions for common operations in the ICP Expert 
Help. To access this information: 
1 Double-click the ICP Expert Help and Learning Center icon on the desktop. 
2 When the ICP Expert Help appears, click ‘How to’ to view the available step-by-

step instructions. 

Analysis Checklist 

You need to complete the following steps in turn to measure a sample/s. You will 
find information on each step in this chapter. 
 Turn on the PC, instrument and software 
 Connect the software to the instrument 
 Prepare for analysis 
 Perform a dark current scan and wavelength calibration 
 Create/open a worksheet 
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 Develop a method 
 Run samples 
 Print a report 

Turning On the Instrument and Software 

Before starting the system, carefully read the Safety practices and hazards section 
at the front of this manual and ensure that the laboratory is set up according to the 
details specified in the Site Preparation Guide. 

Turning on the instrument for the first time (or from long term shutdown) 

To turn on the instrument for the first time or from shutdown: 
1 Check that the exhaust and External Inlet Duct Adapter (if used) lines are 

secured to the ICP-OES instrument, and that the air filter is not blocked. 
2 Turn on the laboratory exhaust system. 
3 Ensure the gas and water lines are connected to the ICP-OES instrument 
4 Turn on the gas supply. 
5 Switch on the water chiller. 
6 Ensure that the gas and water supplies are turned on and set to the correct 

pressures, and that the water chilleris set to the correct temperature. 
7 Check that the torch is clean and in good condition and installed with the torch 

handle fully closed. 
8 Check that all tubing on the spray chamber, nebulizer and peristaltic pump is 

installed and correctly connected. 
9 Check that the plasma compartment door is fully closed. 
10 Check that the Ethernet LAN cable is connected to the computer or Local Area 

Network. 
11 Switch on the computer, monitor and printer. 
12 Plug the ICP-OES cable into the wall socket and set the mains power switch on 

the left side of the instrument to ‘On’.  
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13 Press the Power on/off button on the front of the instrument. The power 
on/off LED will display green when it is on. The ICP-OES is now in standby 
state, which continually purges and thermostatically controls the 
polychromator. 

NOTE Both the mains power switch on the left side of the instrument and front panel 
power button must be on for the instrument to work. 

 

14 Double-click the ICP Expert desktop icon to start the ICP Expert software. The 
Start page will appear. 

Running the instrument from standby 

During standby state (both power switches are ‘On’), the polychromator 
temperature is regulated and polychromator gas purge is running to ensure the 
instrument is ready for analysis within 20 minutes after lighting the plasma. 

To begin using the instrument from standby state: 
1 Turn on the laboratory exhaust system. 
2 Check that the torch is clean and in good condition and installed with the torch 

handle fully closed. 
3 Check that all tubing on the spray chamber, nebulizer and peristaltic pump is 

correctly connected. 
4 Check that the torch compartment door is fully closed. 
5 Switch on the monitor and printer (if they are off). 
6 Switch on the water chiller (if it is off).  
7 If you have accessories fitted, switch them on. 

Preparing for Analysis 

To prepare for analysis: 
1 Click the Plasma button in the ICP Expert software. Alternatively, press F5 or 

choose Plasma on from the arrow under the Plasma button.  
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NOTE The plasma ignition sequence will take up to 60 seconds to complete. If the plasma 
fails to ignite, refer to the Troubleshooting section in the Help and Learning Center 
for further information.  

 

NOTE For optimum performance and stability, for the ICP-OES instrument a warm up time 
of 20 minutes is recommended after igniting the plasma.  

If using wavelengths below 189 nm: purging the polychromator can take up to 
several hours. The polychromator thermal stabilization can take up to several hours 
from long term shutdown. 

 

2 Ensure that the peristaltic pump is correctly set up (refer to the Peristaltic 
Pump section of the ICP Expert Help and Learning Center). If you have not 
already done so, adjust the pressure bars on the peristaltic pump for even 
sample flow and drainage. 

3 Place the sample tubing from the peristaltic pump into the rinse solution and 
the drain tubing into the drainage vessel. 

4 Click the Pump button in the ICP Expert software and choose Normal (15 rpm) 
from the arrow under the Pump button. The pump will be initialized and the 
solution will begin aspirating.  

Performing a Detector and Wavelength Calibration  

See Page 24 for instructions. 

Creating/Opening a Worksheet 

Creating a new worksheet 

To create a new worksheet, click New Quantitative or IntelliQuant Screening from 
the Start page or the File menu.  
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A list of recently used files will be presented when creating a new worksheet from 
a template; otherwise you may Browse for more files. The ‘New From Template’ 
dialog box will be displayed in this instance. 

Opening an existing worksheet 

To open an existing worksheet: 
1 Click Open from the Start page or from the File menu.  
2 A list of recently used files will be displayed. Otherwise, you may Browse for 

more files. The ‘Open’ dialog box will be displayed in this instance. 

Creating a new worksheet from a template 

To create a new worksheet from a template click New From on the Start page or 
New From Template from the File menu.  

A list of recently used files will be presented, otherwise you may Browse for more 
files. The New From Template dialog box will be displayed in this instance. 

The Worksheet window will appear with the new worksheet loaded. 

Developing a Method 

NOTE For instructions on how to configure and use accessories, IntelliQuant, and 
Extended QC options, see the ICP Expert Help and Learning Center. 

To develop a method: 
1 Open a new worksheet or one from a template. 
2 Select the features and accessories on the Configuration page to be used 

during analysis. (Some features are only available in ICP Expert Pro software.)  
3 On the ‘Elements’ page, select the element(s) from the ‘Element’ drop-down 

box or type the element name or symbol and then perform one of the 
following:  
 Click Add Analyte to add the primary wavelength for the selected element.  
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 Highlight the wavelength you wish to use from the list of available 
wavelengths displayed. Click Add.  

NOTE Alternatively, press CTRL and select the element from the periodic table to add the 
primary wavelength for the selected element to your method. 

The element will appear in the table with the selected wavelength and default 
settings selected. 

NOTE It is recommended to add multiple wavelengths for each element. Similar results for 
each wavelength indicate there are no interferences present. If there are different 
results, check IntelliQuant for the right wavelength to report. 

4 Check that there are no known interferents or other analytical lines close to the 
selected analytical line. Their relative intensity will govern how close the lines 
can be to each other. For example, if your matrix contains an element that is 
not of analytical interest, but is a potential interferent and has a line close to 
one of your analytical lines, the concentration of that element in your matrix 
will determine whether you need to choose another analytical line.  

5 Make any required adjustments to each element including selecting a different 
wavelength, entering additional information into the ‘Label’ column, and 
selecting the type (choose from analyte, internal standard or interferent).  

6 Click Conditions to modify both common settings for the run and settings for 
each element. Up to eight different measurement conditions can be used.  

7 Click QC to enter the method detection limits, select the QC tests to be used 
and which error actions should be performed if an error occurs.  

8 Click IEC to enter the concentration of the elements in your analyte and 
interferent standards. 

9 Click Standards to enter the concentration of the elements in your standards 
and select whether to use other options such as Standard Additions or 
MultiCal. In addition, also select whether to use the blank in calibrations and 
whether to enable reslope. 

10 Click Sequence to specify the number of samples, insert QC tests, select the 
solution type, edit the sample labels and end of run actions. 

11 Click FACT to manually create FACT models or to set the method up to 
automatically create them during analysis. 

12 If you are using an autosampler, click the ‘Autosampler’ tab to select the racks 
and probe depth (if needed). Depending on the autosampler selected, options 
may vary. 
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NOTE See the ICP Expert Help and Learning Center for a more detailed description of 
setting up a method. 

 

Running Samples 

To run samples: 
1 Set up the autosampler with all solutions, if required. 
2 Click the Analysis tab and do the following: 

a Ensure your samples are selected. This will be indicated by a check next 
to the Rack:Tube column. To select all solutions, select the checkbox next 
to the Rack:Tube title. 

 

 
b Click the Run icon in the toolbar (or press the SHIFT+F8 keys) to begin the 

analysis, and follow the prompts. 

NOTE 
For further information about running an analysis, refer to the ICP Expert Help and 
Learning Center. 

 

Printing a Report 

To print a report: 
1 Click Report on the toolbar or File > Report. 
2 Choose whether you want to print or preview the report or save the report as a 

PDF file. 

TIP Previewing the report allows you to ensure that you have included all of the data you 
require. 

 

3 Select a report template and then click Open. 
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4 Click the Print button to generate a report as specified. A message will appear 
briefly indicating the progress status of the report being generated. 

5 The Print dialog box will then be opened. You can select to print all of the 
report, or a range of pages. Reports are printed to your default printer, unless 
you specify otherwise. You can specify your printer options in the Print Setup 
dialog box, accessible from the File menu. 

Turning Off the Instrument 

There are three standby and shutdown modes: 
 Standby Mode with argon on – for in between routine use (Page 47) 
 Standby Mode with argon off – for overnight, weekend, and long-term 

shutdown (Page 47) 
 Full shutdown – for a complete shutdown (Page 48) 

Instrument Standby Mode with argon on  

This Standby Mode option leaves the 5800/5900 ICP-OES in a state of readiness 
while only consuming low amount of utilities (argon gas and electricity). The 
benefit of being in Standby Mode is the 5800/5900 can be operational again in <20 
minutes from plasma ignition. Standby Mode is automatically enabled once the 
previous analysis is finished and the plasma is shut down. Follow ‘Setting the 
instrument to Standby Mode with argon on or off’ on Page 47 to ensure the 
instrument is fully prepared for Standby Mode. 

Typical recommendation for Standby Mode is to leave the ICP-OES power on and 
the argon gas supply pressured up, allowing a trickle purge of argon through the 
polychromator, while not collecting analytical data. 

To get back to operational status from this mode, turn on the plasma and stabilize 
for 20 minutes. 

Instrument Standby Mode with argon off 

For overnight, weekend, and long-term shutdown is recommended the instrument 
is fully powered but the plasma off. In this mode the purge systems are also 
turned off. The internal air cooling system runs at reduced capacity. 
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This Standby Mode option will further reduce utilities consumption. The ICP-OES 
can have the power left on, and the argon gas can be completely turned off. Follow 
‘Setting the instrument to Standby Mode with argon on or off’ on Page 47 to 
ensure the instrument is fully prepared for Standby Mode.  

To get back to operational status from gas off, activate the software and turn on 
the gas with the ICP-OES power on and leave to purge for 30 minutes prior to 
activation of water chiller or plasma. This 30 minute purge is needed to remove 
any atmospheric water vapor from the optics. 

 

NOTE Turning off the argon is not recommended, especially if you are routinely analyzing 
lines below 190 nm. Turning off the argon gas will reduce the consumption of 
utilities however, it will take longer for the ICP-OES to get back to operational status 
for deep UV lines once the argon gas is turned back on.  

 

NOTE If you are turning off the argon gas, also turn off the water chiller. 

Setting the instrument to Standby Mode with argon on or off 

To put the instrument into Standby Mode: 
1 Rinse the spray chamber by aspirating water for a few minutes. 

NOTE When running organic samples it is recommended that the spray chamber be 
cleaned and dried thoroughly between analyses. 

 

2 Extinguish the plasma by clicking the Plasma Off icon, pressing SHIFT + F5 on 
the keyboard or choosing Plasma Off from the Analyze menu. The peristaltic 
pump stops automatically when the plasma is extinguished. 

3 Turn off the polychromator boost overnight, by deselecting Polychromator > 
Boost on the Status tab on Instrument window.  

4 For Standby Mode with argon off only: Turn off the argon gas supply. 
5 To increase the pump tubing lifetime, loosen the peristaltic pump tubes by 

releasing the pressure bars and lift the tubes out of the grooves. To do this: 
a Push up the pressure bar screws. This releases them from the pressure 

bar (refer to Figure 13). 
b Allow the pressure bar to swing downwards. 
c Lift the tubing out of the grooves. 
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Figure 13. Peristaltic pump with pressure bar screws pushed up and pressure bar freely down, 
allowing tubing to be loosened 

6 Turn off the water chiller. 
7 Close the worksheet by clicking ‘Close’ from the ‘File’ menu but leave the ICP 

Expert software running. You may switch off the printer, monitor and any 
accessories if desired.  

Ensure that the Powersave option on your PC is disabled (this will prevent the 
shutdown of your hard disk). If this option is not disabled, you could lose data 
during an unexpected shutdown. 

WARNING 

 
 

Noxious Fumes 
Inhalation danger. The exhaust system MUST remain on if the gas supplies 
are on. 

Turning off the instrument for long term shutdown 

For extended periods of disuse, fully shutdown the instrument. This turns off all 
purging as well as the polychromator thermostatting system). 
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To shut down your instrument completely: 

CAUTION The ICP-OES gas control unit supplies uninterrupted gas purge to the 
polychromator assembly during the run and idle states only to minimize the 
ingress of moisture. It is recommended that both the instrument and gas 
supplies be left on at all times except during long periods of non-use. 

 

1 Follow Steps 1-7 of the Standby Mode procedure. 
2 Switch off any accessories (where applicable), and then shut down the argon 

gas supply at the cylinder.  
3 Switch off the power at the front lower left of the instrument. 
4 Wait for the front power on/off switch green LED to stop blinking and then 

switch off the mains power switch on the left side of the instrument. This will 
turn off the complete instrument as well as the polychromator thermostatting 
system. 

5 Turn off the laboratory exhaust system. 
6 Exit the ICP Expert software, if it is no longer required, by choosing Exit from 

the File menu. Switch off the printer and monitor. 

Restarting the instrument to be ready for analysis again will take several hours due 
to the gas purge and polychromator thermal stabilization time. See Page 40 for full 
start up instructions. 

NOTE If the instrument is not going to be in use for a period of time the torch, cone, snout 
and torch compartment should be cleaned of any deposits, dirt or residue. Check 
the cleanliness of the removable axial window when cone is removed. 
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This chapter includes the Agilent ICP-OES maintenance requirements that may be 
carried out by an operator. Any maintenance procedures not specifically 
mentioned in this chapter should be carried out only by Agilent-trained, Agilent-
qualified or Agilent-authorized field service engineers. 

 

WARNING 

 
 

Eye Hazard 
Always wear appropriate safety glasses when handling sample solutions 
and other chemicals, or when the plasma is on, in order to minimize the risk 
of eye damage by hazardous liquids and exposure to ultraviolet rays. 

 

WARNING 

 
 

Shock Hazard 
This instrument contains electrical circuits, devices and components 
operating at dangerous voltages. Contact with these circuits, devices and 
components can result in death, cause serious injury, or painful electrical 
shock. 
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WARNING 

 
 

RF Hazard and Hot surfaces 
The plasma radiates dangerous levels of radio frequency (RF) energy. 
Exposure to the RF energy can cause severe skin damage and cataracts of 
the eyes, while close contact with the operating plasma can result in severe 
heat burns to the skin, and an electrical discharge which can jump a 
considerable distance and may cause death, severe electric shock or sub-
surface skin burns. 

 

NOTE 
This section refers to maintenance procedures for the ICP-OES instrument. You 
should refer to your accessories, PC, and printer manuals for their maintenance 
procedures, and to the ICP Expert Help for the maintenance procedures for any 
accessories you ordered. 

Routine 

The following parts of the ICP-OES, consumables and accessories require routine 
maintenance. Maintenance instructions are included in the ICP Expert Help and 
Learning Center. To access these instructions, double-click the ICP Expert Help 
and Learning Center icon on the computer desktop. Click on, or search for 
Maintenance. 

The frequency of performing these routine maintenance tasks is dependent on the 
frequency of use and the types of the samples analyzed. With challenging sample 
matrices or for systems running continuously, more frequent maintenance is 
required. 

Hourly 

 Check and, if necessary, empty the drain vessel. 

Daily  

 Check exhaust system and argon gas pressure. 

 Check the water level in the Argon Humidifier before every use (if applicable).  

 Clean the surface of your ICP-OES (spills should be cleaned up immediately). 
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 Inspect torch for injector blockage or other damage. 

 Check nebulizer for blockage or pulsation during operation. 

 Inspect the pump tubing and replace if it is flat or has lost its elasticity. Unclip 
the pump tubes when the pump is not in use. 

 Complete a visual check of the spray chamber to confirm that all connections 
are not leaking and secure, and that the waste is draining correctly. 

Weekly 

 Clean the torch. 

 Inspect cone (axial) or snout (radial); clean if required. 

 Check the other sample introduction tubing and O-rings. 

 Replace peristaltic pump tubing. 

 Clean the nebulizer. 

Monthly 

 Clean the spray chamber. 

 Clean the nebulizer. 

 Check the other sample introduction and transfer tubing and O-rings 
(look for excessive wear, poor sealing or kinks and replace as necessary). 

 Inspect the removable axial and radial pre-optics windows for cleanliness. 
Clean or replace as necessary. 

 Check the condition of the filter in the air inlet on top of your instrument. 
Remove the air inlet filter assembly and replace the filter element if there is a 
build-up of dust and dirt. 

 Check the water level in the water chiller (refer to the manual supplied with the 
water chiller for details). 

 Check/clean the heat exchanger (radiator) on the chiller to remove any build-
up of dust and dirt. 

 Perform a wavelength calibration. 

 Inspect the external gas supply system for leaks including the tubing 
connected to the instrument, and stress cracks. Replace any damaged, 
leaking or worn components.  
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Annually 

 Drain and replace chiller coolant. 

 Replace the argon purge gas filter. 

 Remove and clean the water filter on the right side of the instrument. 

 Periodically, drain the coolant from the cooling system and then refill/ treat 
with an appropriate algaecide (as recommended by the manufacturer). 

Cleaning 

Any spills in the sample compartment should be wiped up immediately.  

The user (or other authorized personnel) must perform the appropriate 
decontamination procedure if hazardous material is spilled on or inside the ICP-OES. 

The exterior surfaces of the ICP-OES should be kept clean. All cleaning should be 
done with a soft cloth. If necessary, this cloth can be dampened with water or a 
mild detergent. Do not use organic solvents or abrasive cleaning agents. 

Before using any cleaning agent, procedure or decontamination method except 
those specified by Agilent, the user (or other authorized personnel) should check 
with your local authorized Agilent field service engineer or representative to 
confirm that the proposed method will not damage the equipment.  

Torch Cleaning 

To help you achieve the maximum usable life from all models of the 5800/5900 
ICP-OES Easy-fit torch, it is recommended that the cleaning procedures are 
followed as soon as any discoloration appears on the outer tube of the torch.  
To maximize torch lifetime and prevent contamination, you should inspect the 
condition and cleanliness of the torch daily. 

See the ICP Expert Help for instructions on how to clean the torch for organic 
based samples and have carbon build-up on the injector. 
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To access the Help, double-click the ICP Expert Help icon on the computer 
desktop. 

CAUTION Do not use cleaning wire or abrasives like brushes or a scourer to clean the torch. 

 

 

Important 

Use a clean, wide diameter, open-top beaker (preferably 100 mL tall form) or a 
similar container to hold the soak solutions. Use the recommended torch cleaning 
stand (see Figure 15A) for 5800/5900 ICP-OES Easy-fit torches (part number 
G8010-68021) to hold the torch inverted while soaking during the cleaning 
process. The torch cleaning stand aids in cleaning the torch, preventing damage to 
the fragile end of the quartz outer tube and limiting exposure of the elastomer 
materials on the torch body to acid fumes, reducing premature degradation.  
 Use clean/particle free detergents or acid to perform the soak. 
 Ensure the acid does not contact the seal between the quartz outer tube and 

the plastic base.  
 Do not soak the removable top seal of semi-demountable torch.  
 Keep the torch vertical, with the ball joint at the top, throughout all cleaning 

and rinsing steps unless otherwise directed. 
 Do not remove the torch adhesive cap on the one-piece torch that covers the 

seal between the quartz and the plastic. 
 For a better clean, always disassemble the semi- or fully demountable torch 

during rinsing and drying procedures.  

WARNING 

 

 

Hot Surface and Chemical Hazard 
The torch and torch compartment become extremely hot during instrument 
operation and remain hot for some time after the instrument has been 
switched off. Allow the torch and torch compartment to cool for at least five 
minutes before attempting to remove the torch. Use heat-resistant gloves.  
Nitric acid, hydrochloric acid and strong alkali solutions are very corrosive 
and can cause severe burns when they come into contact with the skin. 
Preparation of acid soak solutions and any soaking should be done under an 
extraction fume hood. It is essential that appropriate protective clothing be 
worn at all times when handling these acids. If acid contacts the skin, wash 
off with copious amounts of water and seek medical attention immediately. 
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Acid soak cleaning procedure for the torch for aqueous or acid-based 
samples (one piece and semi-demountable torches) 

See Page 27 for demountable torch disassembly instructions. 

 
Figure 14. Torch components where 1. Ball joint, 2. Gas ports, 3. Torch securing ring (demountable 
torch only), and 4. Torch outer tube 

To clean the torch: 
1 Prepare a 50% Aqua Regia solution (1 part deionized water to 1 part Aqua 

Regia) in a wide diameter open beaker. To make Aqua Regia combine 1:3 
concentrated nitric acid: hydrochloric acid. 

2 Place the beaker containing the acid solution under the torch cleaning stand. 
3 Soak the quartz parts of the torch in 50% aqua regia for at least 1 hour. The 

length of time required for the cleaning procedure will depend upon the extent 
of the contamination. Do not leave the torch in the acid for longer than 4 
hours. If deposits remain after using 50% Aqua Regia, repeat the cleaning 
process using a higher concentration of Aqua Regia. 

4 Place the torch in the aqua regia solution through the hole provided in the 
torch cleaning stand as shown in Figure 15A, B, C and D. Ensure the quartz 
outer tube along with the injector is immersed in the solution. 

For soaking the injector without the quartz outer tube-set, the torch injector 
tube plate should be installed to the torch cleaning stand to minimize 
exposure of the torch body to the acid fumes. 

For semi or fully demountable torches, the quartz outer tube-set can be 
removed and soaked separately in a beaker of aqua regia (Figure 15D). 

5 Pipette some of the acid through the ball joint of the injector to remove build-
up from the lower part of the injector. See Figure 16A. 

 

1 

2 

3 

4 
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CAUTION Avoid acid contact with the seal where the quartz meets the plastic base. 
Damage to the seals and torch body may occur. 

 

NOTE A torch cleaning stand is available from Agilent which helps keep torches upright 
and steady during cleaning. See the Agilent website www.agilent.com for details. 

 

6 Keep the one-piece torch inverted through all the cleaning and rinsing steps 
unless otherwise directed.  

 
Figure 15A. Soak the torch in the aqua regia solution. Ensure the injector is immersed in the 
solution. 
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Figure 15B and C. Assembled torch cleaning stand with swappable torch plates. Injector soaking in 
aqua regia. 

 
Figure 15D. Quartz outer tube-set soaking in aqua regia. 

7 Rinse the torch and outer tube-set thoroughly and dry completely prior to 
using the torch in the instrument.  

8 Follow the steps outlined below for “Rinsing the torch” and “Drying the torch” 
listed below.  
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Rinsing the torch 

To rinse the torch (one piece and semi-demountable torches): 
1 Hold the torch with the ball joint connector at the top.  
2 Thoroughly flush the inside and outside of the torch with deionized water 

(18 MΩ.cm) using a wash bottle to direct the water stream. See Figure 16A. 
3 Invert the torch (see Figure 16B) so that the quartz tube or injector are at the 

top and the ball joint connector is at the bottom. Flush rinse water through the 
quartz tubes so that the water flows out of the gas entry ports and ball joint 
connector for at least 1 minute. 

 
Figure 16A. Rinse the injector with deionized water through the ball joint connector. 
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Figure 16B. Flush the gas ports and ball joint connector with deionized water. 

4 If the torch was disassembled for cleaning, thoroughly wash the quartz outer 
tube-set and the removable top seal. See Figure 17A and Figure 17B. 

  
Figure 17A and B. Rinse the quartz outer tube-set and top seal with deionized water. 

5 Dry the torch completely and re-assemble the semi-demountable torch if 
necessary, prior to using the torch on the instrument.  
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NOTE For high total dissolved solids (TDS) samples such as soil digests, soak the quartz 
parts of the torch in a 5% v/v detergent solution for 10 minutes after the initial acid 
cleaning step. Always rinse the torch thoroughly and dry completely prior to using 
the torch in the instrument. Follow the steps outlined above for “Rinsing the torch” 
and “Drying the torch” below. This extra step can help to reduce deposition on the 
outer tube of the torch.  

 

CAUTION Do not place the plastic parts of the torch in a drying oven. It is not as effective at 
removing moisture as using compressed air, argon or nitrogen and may damage 
the torch. 

 

Drying the torch 

1 Hold the torch inverted (with the ball joint connector at the top). 
2 Blow clean compressed air, argon or nitrogen through the gas supply ports on 

the base and through the opening of the ball joint connector to remove 
moisture. See Figure 18A and Figure 18B. 

 
Figure 18A and B. Use compressed air, argon or nitrogen to dry the torch. 
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3 Blow clean compressed air, argon or nitrogen through the open end of the 
quartz outer tube-set. Do not insert the air nozzle inside the tube-set. See 
Figure 19. 

 
Figure 19. Blow clean compressed air, argon or nitrogen through the open end of the tube-set. 

4 If the torch was disassembled for cleaning, blow clean compressed air, argon 
or nitrogen through the quartz outer tube-set and top seal to remove all 
moisture.  

5 Carefully blow away any moisture left on the body of the torch and quartz 
parts. 

6 Ensure that all moisture is removed before refitting the torch into the 
instrument. 

7 For the semi- and fully demountable torch, it is advisable to disassemble the 
torch giving easy access to the torch body for complete drying. 

Additional checks after cleaning 

Perform the following checks after cleaning: 
1 Inspect the torch for damage such as loose fitting of the quartz tubes in the 

plastic base, holes or significant cracks. If any damage is found, replace the 
torch immediately. 
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2 Check for carry-over after refitting the torch to the instrument to determine if 
the cleaning procedure has been sufficient. If carry-over is found, repeat the 
cleaning process. 

3 Replace the torch when the outer surface of the quartz outer tube is rough to 
the touch (which indicates signs of wear), or if there are any cracks visible.  

NOTE Long term exposure to acid during cleaning may lead to discoloration of the plastic 
base. This change is cosmetic only and should not impact performance if the torch 
is clean and the results of the other torch checks are satisfactory. 

TIP Store the torch in the original box or a plastic bag when not in use, or alternately, 
use the Agilent ICP-OES Easy-fit torch storage rack (P/N G8010-67000).  

Troubleshooting 

For troubleshooting information, please see the ICP Expert Help and Learning 
Center: 
1 Double-click the ICP Expert Help and Learning Center on the computer 

desktop. 
2 Click on, or search for Troubleshooting to view instructions on how to 

troubleshoot. 

Spare Parts 

For spare parts and consumables ordering information, refer to the Agilent 
Technologies website: 

www.agilent.com 

To replace the items listed below, you must use Agilent-manufactured parts, which 
can be ordered online from the Agilent website or through your local sales 
representative. 
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When replacing the communications cable, always use a “Category 5E Patch Cord, 
STP/FTP, Shielded, Stranded, White, 14 ft, Booted” rated Ethernet cable to maintain 
EMC compliance. 

The following is a list of recommended spares to keep on hand to minimize 
downtime during maintenance and repairs: 
 Torch (one piece) or spare components such as the outer tube-set and 

injector, if using a demountable torch 
 Air inlet filter element (dust filter) 
 Axial pre-optic window 
 Radial pre-optic window 
 Spray chamber 
 Nebulizer 
 Peristaltic pump tubing 
 Drain tubing 

Technical Support 

For technical support contact information, refer to the Agilent Technologies 
website for details: 

www.agilent.com 
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